Updates and Enhancements to the LOSPLAN User Interface and Computational Procedures

Final Report
October 2003

Contract #: BC 354 RPWO 65
UF Project #: 4910-4504-893-12

Prepared for:
The Florida Department of Transportation

Prepared by:
Transportation Research Center
Department of Civil and Coastal Engineering
University of Florida
Updates and Enhancements to the LOSPLAN User Interface and Computational Procedures

This report summarizes the results of several tasks performed to improve and enhance the Florida Department of Transportation's (FDOT) LOSPLAN suite of software programs. Initial development of the LOSPLAN programs was conducted under a previous contract (BC-354-38). Specific accomplishments from this project include:

- Revisions, refinements, and debugging of the user interfaces and calculations,
- Revisions and updating of electronic help resources,
- Refinements of the program code structures to reduce computer resource consumption,
- Development of a batch processing utility,
- Integration of a remote automation capability,
- Demonstration of the potential for database interfacing with the LOSPLAN programs,
- Revision of the XML input routine,
- Development of dynamic link library (DLL) implementations of the calculations code, and
- Development of a preliminary version of CORPLAN.

Level of service planning software, level of service planning methodologies, level of service
Table of Contents

Introduction..................................................................................................................................... 1
Overview of ARTPLAN, HIGHPLAN, and FREEPLAN Programs .............................................. 3
Program Optimization..................................................................................................................... 4
Batch Processing Utility and Remote Automation Feature .......................................................... 5
  Batch Processing Utility ........................................................................................................... 5
  Remote Automation .................................................................................................................. 5
Database Interfacing ....................................................................................................................... 6
MSXML Parser ............................................................................................................................... 8
Calculations Dynamic Link Library (DLL) .................................................................................... 9
CORPLAN (Corridor Planning) ................................................................................................... 10
Appendices.................................................................................................................................... 21
  Appendix A: LOSPLAN Component Program User Interface Screens ................................ 22
  Appendix B: LOSPLAN Component Program Revision Histories ....................................... 35
  Appendix C: Batch Processing Instructions .......................................................................... 44
  Appendix D: Database Interface Example .......................................................................... 52
  Appendix E: DLL Documentation ......................................................................................... 76
INTRODUCTION

This report summarizes the results of several tasks performed to improve and enhance the Florida Department of Transportation’s (FDOT) LOSPLAN suite of software programs. Collectively, the FDOT planning level of service software is grouped under the name LOSPLAN, with the three primary component programs being ARTPLAN, FREEPLAN, and HIGHPLAN, each of which implements the HCM analysis procedures for their respective facilities (arterials, freeways and highways). The LOSPLAN programs complement the 2002 Q/LOS Handbook and are integral to the quality/level of service program for the FDOT.

Initial development of the LOSPLAN programs was performed under Task 1 (Updated Procedures for Florida Department of Transportation Planning Level Software Tools) of contract#: BC-354-38 (Facility Performance Model Enhancements for Multimodal Systems Planning).

With initial program design and development performed under this previous contract, this project was focused on improvements and enhancements to the LOSPLAN component programs, ARTPLAN, FREEPLAN, and HIGHPLAN, as well as the development of a new corridor planning analysis program. Specifically, the following tasks were addressed under this contract:

- Refine the user interface of the existing LOSPLAN programs,
- Refine and test the computational methodologies of the existing LOSPLAN programs,
- Extend the computational capabilities of the existing LOSPLAN programs, and
- Develop a new LOSPLAN component program that would integrate the analysis capabilities of the existing LOSPLAN programs into a corridor analysis program.

The specific accomplishments of this project include the following:

- Revisions, refinements, and debugging of the user interfaces
- Revisions, refinements, and debugging of the calculations
- Revisions and updating of electronic help resources
- Refinements of the program code structures to reduce computer resource consumption
- Development of a batch processing utility
- Integration of a remote automation capability
- Demonstration of the potential for database interfacing with the LOSPLAN programs
- Revision of the XML input routine
- Development of dynamic link library (DLL) implementations of the calculations code
- Development of a preliminary version of CORPLAN

The remaining sections of this report give specific details about each of the project accomplishments listed above.
The project was a combined effort between the Transportation Research Center (TRC) at the University of Florida and Polytechnic University of New York. Specific task responsibility by principal researcher was organized as follows:

- ARTPLAN user interface issues (Scott Washburn, UF-TRC)
- ARTPLAN calculations issues (Elena Prassas, Polytechnic)
- HIGHPLAN user interface and calculations issues (Scott Washburn, Kenneth Courage, UF-TRC)
- ARTPLAN and HIGHPLAN electronic documentation (Scott Washburn, UF-TRC)
- FREEPLAN user interface and calculations issues (Elena Prassas, Polytechnic)
- FREEPLAN electronic documentation (Elena Prassas, Polytechnic)
- Batch Processing Utility (Scott Washburn, Kenneth Courage, UF-TRC)
- Remote Automation Capabilities (Scott Washburn, Kenneth Courage, UF-TRC)
- Database Interface Sample (Scott Washburn, UF-TRC)
- DLL development (Scott Washburn, UF-TRC)
- CORPLAN development (Scott Washburn, UF-TRC)
OVERVIEW OF ARTPLAN, HIGHPLAN, AND FREEPLAN PROGRAMS

Details of the initial versions of the LOSPLAN programs were covered in the BC-354-38 final project report, which can be obtained from the following website:


Additional details of the software, including an overview of the computational methodologies, can be found in the FDOT Quality/Level of Service Handbook.

www11.myflorida.com/planning/systems/sm/los/los_sw2.htm

User interface revisions/alterations suggested by beta testers were discussed between FDOT staff and TRC and/or Polytechnic researchers. Some of the suggestions were subsequently incorporated. Several revisions to the LOSPLAN user interfaces were also requested directly by FDOT staff. All but the ones requiring significant alteration of the code were incorporated. Additionally, any identified software bugs during the testing process were corrected.

The final user interface screens are shown in Appendix A.

The revision histories for the ARTPLAN and HIGHPLAN versions released, for testing and official purposes, are included in Appendix B. A detailed revision history was not maintained for FREEPLAN.

The latest versions (June 2003) of the ARTPLAN, HIGHPLAN, and FREEPLAN programs are included on the enclosed CD. Also included are the latest electronic help files (which were converted from their previous Windows format to the newer HTML format).
PROGRAM OPTIMIZATION

The initial versions of the LOSPLAN programs were developed in an incremental manner using a continuous input/feedback loop between TRC researchers and FDOT staff during the preliminary design stage. Consequently, the program software architecture was not constructed with optimization as a primary objective. Once the functional requirements and user interface (UI) design became fairly stable, the underlying software code and program architecture could be optimized. Optimization of resource utilization is a very important consideration for the final release of the software, as most users of the software will not have new computers with very fast processors and very large amounts of Random Access Memory (RAM).

This task of optimization, for ARTPLAN, was performed over an approximately three-month period and resulted in a substantial reduction in resource utilization. The two figures below show the resource utilization for an example “average” computer with the latest non-optimized version, and the resource utilization with this same version after the optimization. As seen in these figures, the resource utilization was improved substantially through the optimization of the software code and program architecture.

The ARTPLAN computational engine was reviewed for potential memory usage efficiency improvements. Variable type definitions (e.g., integer vs. single) were reviewed and changed where possible to minimize memory allocation.

Note: Only ARTPLAN and the operating system running

![Resource Meter Before optimization](image1)

![Resource Meter After optimization](image2)

An optimization process analogous to that performed for ARTPLAN was also performed for HIGHPLAN and FREEPLAN. Resource utilization was not as critical an issue for HIGHPLAN due to its lesser complexity relative to ARTPLAN. Nonetheless, it was important to optimize HIGHPLAN to the extent possible so as to minimize its impact on system resources, particularly when other programs may be running at the same time.
BATCH PROCESSING UTILITY AND REMOTE AUTOMATION FEATURE

Batch Processing Utility

The batch processing utility was developed to allow multiple files to be processed automatically. This processing includes loading an input file, performing the level of service calculations for those inputs, and then saving those results back into the input file.

The instructions for using the batch processing utility are included in Appendix C.

Remote Automation

ARTPLAN, HIGHPLAN, and FREEPLAN have been structured to be executable with command line arguments that will bypass the user interface and execute the computations directly using a data file name supplied on the command line.

The remote automation is executed through command-line arguments. Command line instructions and arguments are typically specified through either the DOS command prompt or a shell-type command from within another program.

When a program is executed with no command line arguments, it opens in the current fully interactive mode with the default values displayed for all data items. When a file name is present as the first command line argument, the data from that file shall be loaded. If the command line argument “/R” is present with a data file name, the following action shall occur:

- Computations shall be performed on the data that were loaded from the specified file, ignoring any performance measures that were included in the file.
- The complete data file including performance measures shall be overwritten, using the originally specified file name.
- The program shall terminate.
- The screen display prior to the program execution shall not be disturbed.

If a file name is specified but the “/R” argument is not present on the command line, the data values shall be displayed in place of the default data and the normal interactive operation shall commence.

The batch processing utility uses this feature to interact with the LOSPLAN programs.
DATABASE INTERFACING

In previous LOS Task Team meetings, the issue of being able to interface existing FDOT district databases (of roadway, traffic, and control characteristics) with the computational processes of the LOSPLAN programs was raised.

For a district that maintains an inventory-type database that contains all of the necessary inputs to the LOSPLAN programs, it would be preferred to be able to export that data automatically into a file format that can be opened by the LOSPLAN programs. The alternative is to manually enter the data directly into the user interface of an LOSPLAN program. This is undesirable because it is inefficient, as the data have already been entered into an electronic format (i.e., the database), and entering the same data multiple times increases the opportunities for making a data entry mistake.

To address the issue, the TRC researchers developed a small demonstration database and conversion utility to take the contents of a database and put them in an LOSPLAN file compatible format. A sample database was designed to demonstrate how the LOSPLAN programs can interface with a database system of roadway, traffic, and control variables. An example Microsoft Access database was developed for this purpose. Note, however, that any database software that is XML compatible can be utilized. A brief description of XML is given in the next section.

The sample database contains typical inputs for an ARTPLAN analysis. These are in the form of tables. This is where a database user would typically enter their data. Queries were developed to extract the desired input data from the appropriate tables. These queries were then exported in XML format (while this process is done manually for the purposes of the demonstration, an Access macro can easily be written to automate this task). A conversion utility was written to organize the exported Access XML files into one XML file that is compatible for input into ARTPLAN. This file can then be loaded into ARTPLAN like any other file that was originally saved from ARTPLAN.

A detailed step-by-step tutorial to the demonstration is given in Appendix D. The sample database and conversion utility is included on the enclosed CD.

The greatest potential utility for this feature comes when combining it with the remote automation capabilities of the LOSPLAN programs (as described in the previous section). This would allow a database user to never have to directly interact with an LOSPLAN program. The user simply initiates the process that extracts their input data from the database and puts it into an LOSPLAN compatible file format. This process would then initiate the remote automation capability whereby the file created from the database input data is automatically loaded into the appropriate LOSPLAN program, the results calculated and then saved back into the data file. Although not developed as part of this demonstration, the database-LOSPLAN interface utility can also incorporate a component to handle the reverse direction of data flow. Once the LOSPLAN program has calculated and saved the results back into the data file, the utility could automatically extract the results from the file and place them into a specified database location.
Note that this is a fairly simple example and demonstration. Access contains a rich set of features for working with XML. In particular, XML schemas and stylesheets can be accommodated within Access, thus providing considerable control over the way XML data is organized, exported, and displayed.
MSXML PARSER

The traffic modeling markup language (TMML) was chosen as the format for writing saved LOSPLAN files. TMML is based on XML (Extensible Markup Language). XML describes the general requirements (formatting, syntax, etc.) that files must conform to be XML compliant. More information on XML can be obtained from the World Wide Web Consortium (W3C) website at:

http://www.w3.org/XML/

TMML is a traffic modeling vocabulary implementation of XML. More information on TMML can be obtained at:

http://www.ce.ufl.edu/trc/research/tmml.htm

The custom routine that was written to read TMML-formatted files in the original LOSPLAN programs was replaced with a commercial utility for performing this task (ARTPLAN and HIGHPLAN only). This utility is produced by Microsoft, and is called MSXML (version 4) and is designed specifically for the purpose of reading files written in an XML-compliant format. This utility is distributed freely. This change was made because Microsoft’s utility is more robust to the full features and specifications that are possible with XML formatted files. This capability will allow the LOSPLAN programs to read files generated from third-party programs as long as their format is XML-compliant and the content contains the appropriate subset of the TMML vocabulary for the intended LOSPLAN program (i.e., arterial data for ARTPLAN, highway data for HIGHPLAN, freeway data for FREEPLAN).

More information on the MSXML utility can be found on Microsoft’s web site at the following website:


Example TMML files for each of the LOSPLAN programs are included on the enclosed CD.
CALCULATIONS DYNAMIC LINK LIBRARY (DLL)

The calculations for each of the LOSPLAN programs were implemented in dynamic link library (DLL) files. The result is an implementation of the calculations that is completely separate from the core program code, in particular the user interface and file input/output code. The advantage to this approach is that the calculations can be called from a user interface (i.e., data input program) developed by another party. This capability was developed mostly in response to the desire of several consultants within the state to develop their own user interface for the ARTPLAN calculations methodology. The data validation routines have been duplicated within the DLLs and are applied when a DLL is first called by a user interface application. If there is any issue with the integrity of the input data, an error message will be displayed, the calculations process will terminate, and program control will be returned to the DLL calling application.

The supporting documentation on how to implement and interface with the DLLs for each of the LOSPLAN programs is included in Appendix E. The DLL files are included on the enclosed CD. These files and supporting documentation will be available on the FDOT’s Level of Service website (www11.myflorida.com/planning/systems/sm/los/los_sw2.htm).
CORPLAN (CORRIDOR PLANNING)

The tasks in this group relate to the integration of the three existing component programs into a comprehensive corridor analysis tool, which was one of the principal project objectives.

A corridor is considered to contain two or more parallel routes that carry traffic in the same general direction and function as a system. Each route consists of either an arterial, a freeway, or a highway facility. CORPLAN allows the performance of two or more parallel facilities (routes) within a corridor to be compared. CORPLAN is currently constrained to the comparison of like facilities within the same corridor (i.e., arterial vs. arterial, freeway vs. freeway, highway vs. highway). This constraint was the result of LOS Task Team feedback in which it was expressed by a strong majority that they did not want to allow comparisons across differing facility types (e.g., freeway vs. arterial).

The remainder of this section gives an overview of the functionality of CORPLAN.

Figure 1 shows the corridor properties screen. This is where the basic information about the corridor being studied is entered. General file information is also entered on this screen.
Under the ‘Facility Type’ input field (see Figure 2), an arterial, highway, or freeway facility can be selected. CORPLAN currently constrains a corridor analysis to the same type of facility. That is, multiple arterials within a corridor can be compared, or multiple highways, but arterials cannot be compared to highways within the same corridor, etc. Additionally, another current constraint is that all routes must be parallel. The remaining data input fields are self-explanatory.

Figure 2. Facility Type Input Field Options

The Facility Data screen (accessed by the intersection toolbar button or from the ‘View’ menu), Figure 3, consists of two screens, Facility Properties and Facilities Report. From the Facility Data screen, the user can select the facility data files to be included in the corridor analysis. Up to six parallel facilities (again, of the same type) can be specified for a single corridor. These files are specified by pressing the ‘Open File’ button. The open data file dialog box (Figure 4) will prompt you for filenames specific to the facility type indicated on the Corridor Properties screen, as denoted by the two letter prefix in front of the filename (i.e., ‘AP’, ‘HP’, or ‘FP’). The file will be entered into the currently active row, indicated by the adjacent radio button selection.
Once a facility file is opened, basic summary information for that facility analysis will be displayed. Note that if the type, direction, or study period from the facility file do not match with the values specified on the Corridor Properties screen, an error message will be generated and the file loading process will be aborted.

Pressing the ‘Edit Inputs’ button launches the applicable LOSPLAN program (displaying the facility data screen) and loads the file specified in the filename box that has the radio button next to it selected. This allows a user to make input edits, rerun the level of service results, and resave the file. Once the LOSPLAN program is closed, the file will be automatically reloaded into CORPLAN, displaying any new results.

Pressing the ‘View Report’ button performs a similar function as above, but the print preview screen is displayed (showing the formatted report), with inputs and level of service results. While the user can also edit the file in this mode, upon closing the LOSPLAN program, the file will not be automatically reloaded into CORPLAN.

Figure 3. Facility Data (Facility Properties)
Figure 4. Open Data File Dialog Box

The Facilities Report screen (Figure 5) displays summary level of service results.

Figure 5. Facility Data (Facilities Report)
Pressing the ‘LOS’ button on the toolbar, or selecting ‘LOS Hotspots’ from the ‘View’ menu, displays a summary of level of service results for individual segments meeting the specified LOS selection criteria (Figure 6). Note that this button or menu item will not become active until at least a valid facility file has been loaded into the Facility Data screen.

![LOS Hotspots Screen](image)

**Figure 6. LOS Hotspots Screen**

The drop-down list boxes above each results display list box can be used to change the LOS criterion for displaying results (see Figure 7 and Figure 8). Tabbing out from this list box or pressing the ‘Refresh Results’ screen will automatically update the display according to the selected criteria for all results display boxes.
Figure 7. Changing the LOS Criterion for Displaying Auto Segment Results
Figure 8. Updated Results Display After Changing All LOS Criteria
Figures 9 through 12 show some additional screen shots for HIGHPLAN and FREEPLAN loaded facility files.

Figure 9. HIGHPLAN Files Loaded Into Facility Properties Screen
Figure 10. Facilities Report Screen for Loaded HIGHPLAN Files
Figure 11. FREEPLAN File Loaded Into Facility Properties Screen
Figure 12. Facilities Report Screen for Loaded FREEPLAN File

The current version of CORPLAN is included on the enclosed CD.
APPENDICES
APPENDIX A:

LOSPLAN COMPONENT PROGRAM USER INTERFACE SCREENS
Updates and Enhancements to the LOSPLAN User Interface and Computational Procedures

Figure 13. ARTPLAN General Facility Data Input Screen

Figure 14. ARTPLAN Multimodal Facility Data Input Screen
Figure 15. ARTPLAN Intersection and Segment Data Input Screen

Figure 16. ARTPLAN Multimodal Segment Data Input Screen (Bicycle/Pedestrian/Bus)
Updates and Enhancements to the LOSPLAN User Interface and Computational Procedures

Figure 17. ARTPLAN Pedestrian Subsegments Data Input Screen

Figure 18. ARTPLAN Results Screen (Automobiles)
Figure 19. ARTPLAN Results Screen (Multimodal)
### Maximum Service Volumes - Urbanized Area

#### Automobile

<table>
<thead>
<tr>
<th>Lanes</th>
<th>Hourly Volume in Peak Direction</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
</table>
| 1     |                                 |   |   |   |   | 330
| 2     |                                 |   |   |   |   | 750
| 3     |                                 |   |   |   |   | 1890
| 4     |                                 |   |   |   |   | 1620
| *     |                                 |   |   |   |   | 850

<table>
<thead>
<tr>
<th>Lanes</th>
<th>Hourly Volume in Both Directions</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
</table>
| 2     |                                 |   |   |   |   | 550
| 4     |                                 |   |   |   |   | 1360
| 6     |                                 |   |   |   |   | 2140
| 8     |                                 |   |   |   |   | 2340
| *     |                                 |   |   |   |   | 1550

<table>
<thead>
<tr>
<th>Lanes</th>
<th>Annual Average Daily Traffic</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
</table>
| 2     |                                 |   |   |   |   | 6200
| 4     |                                 |   |   |   |   | 14300
| 6     |                                 |   |   |   |   | 22600
| 8     |                                 |   |   |   |   | 31000
| *     |                                 |   |   |   |   | 16300

#### Bicycle

<table>
<thead>
<tr>
<th>Lanes</th>
<th>Motor Vehicle Hourly Volume in Peak Direction</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
</table>
| 1     |                                               |   |   |   |   | 150
| 2     |                                               |   |   |   |   | 300
| 3     |                                               |   |   |   |   | 450
| 4     |                                               |   |   |   |   | 600
| *     |                                               |   |   |   |   | 210

<table>
<thead>
<tr>
<th>Lanes</th>
<th>Motor Vehicle Hourly Volume in Both Directions</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
</table>
| 2     |                                               |   |   |   |   | 280
| 4     |                                               |   |   |   |   | 320
| 6     |                                               |   |   |   |   | 480
| 8     |                                               |   |   |   |   | 640
| *     |                                               |   |   |   |   | 380

<table>
<thead>
<tr>
<th>Lanes</th>
<th>Annual Average Daily Traffic</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
</table>
| 2     |                                 |   |   |   |   | 2900
| 4     |                                 |   |   |   |   | 3400
| 6     |                                 |   |   |   |   | 5100
| 8     |                                 |   |   |   |   | 6700
| *     |                                 |   |   |   |   | 4000

* Service Volumes for the specific facility being analyzed, based on the number of lanes appearing in the segment data screen.

** Cannot be achieved using table input value defaults.

*** Not applicable for that level of service letter grade. See generalized tables notes for more details.

---

**Figure 20.** ARTPLAN Maximum Service Volumes Screen (Automobile)

**Figure 21.** ARTPLAN Maximum Service Volumes Screen (Bicycle)
Figure 22. ARTPLAN Maximum Service Volumes Screen (Pedestrian)

<table>
<thead>
<tr>
<th>Lanes</th>
<th>Motor Vehicle Hourly Volume in Peak Direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A 130, B 610, C &gt; 610, D ***</td>
</tr>
<tr>
<td>2</td>
<td>A 250, B 1210, C &gt; 1210, D ***</td>
</tr>
<tr>
<td>3</td>
<td>A 380, B 1820, C &gt; 1820, D ***</td>
</tr>
<tr>
<td>4</td>
<td>A 500, B 2420, C &gt; 2420, D ***</td>
</tr>
<tr>
<td></td>
<td>A 310, B 1490, C &gt; 1490, D ***</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lanes</th>
<th>Motor Vehicle Hourly Volume in Both Directions</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>A 230, B 1110, C &gt; 1110, D ***</td>
</tr>
<tr>
<td>4</td>
<td>A 460, B 2200, C &gt; 2200, D ***</td>
</tr>
<tr>
<td>6</td>
<td>A 680, B 3310, C &gt; 3310, D ***</td>
</tr>
<tr>
<td>8</td>
<td>A 920, B 4410, C &gt; 4410, D ***</td>
</tr>
<tr>
<td></td>
<td>A 560, B 2710, C &gt; 2710, D ***</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lanes</th>
<th>Annual Average Daily Traffic</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>A 2400, B 11600, C &gt; 11600, D ***</td>
</tr>
<tr>
<td>4</td>
<td>A 4800, B 23200, C &gt; 23200, D ***</td>
</tr>
<tr>
<td>6</td>
<td>A 7200, B 34800, C &gt; 34800, D ***</td>
</tr>
<tr>
<td>8</td>
<td>A 9600, B 46400, C &gt; 46400, D ***</td>
</tr>
<tr>
<td></td>
<td>A 5900, B 28600, C &gt; 28600, D ***</td>
</tr>
</tbody>
</table>

* Service Volumes for the specific facility being analyzed, based on the number of lanes appearing in the segment data screen.

** Cannot be achieved using table input value defaults.

*** Not applicable for that level of service letter grade. See generalized tables notes for more details.

Figure 23. ARTPLAN Maximum Service Volumes Screen (Bus)

<table>
<thead>
<tr>
<th>Buses Per Hour in Peak Direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>A &gt; 7.00, B &gt; 5.00, C &gt; 4.00, D &gt; 3.00, E &gt; 2.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Buses in Study Hour in Peak Direction (Daily)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A &gt; 6.67, B &gt; 4.76, C &gt; 3.81, D &gt; 2.86, E &gt; 1.90</td>
</tr>
</tbody>
</table>

Unlike service volume tables for other modes:

All numbers shown are in terms of buses per hour only for the study hour in the single direction of higher traffic flow, and

The daily reporting table incorporates the daily variable bus span of service, and excludes the planning analysis hour factor (K) and the directional distribution factor (D).
Updates and Enhancements to the LOSPLAN User Interface and Computational Procedures

Figure 24. HIGHPLAN Main Screen Showing Two-Lane Inputs and LOS Results

Figure 25. HIGHPLAN Maximum Service Volume Tables Screen (for Two-Lane)
Updates and Enhancements to the LOSPLAN User Interface and Computational Procedures

Figure 26. HIGHPLAN Main Screen Showing Multilane Inputs and LOS Results

Figure 27. HIGHPLAN Maximum Service Volume Tables Screen (for Multilane)
Updates and Enhancements to the LOSPLAN User Interface and Computational Procedures

Figure 28. FREEPLAN Facility Data Screen

Figure 29. FREEPLAN Segment Data Screen
Figure 30. FREEPLAN Interchange Data Specification Screens
Updates and Enhancements to the LOSPLAN User Interface and Computational Procedures

Figure 31. FREEPLAN Toll Plaza Data Specification Screen

Figure 32. FREEPLAN Results Display Screen
Figure 33. FREEPLAN Worst Case Results Display for Interchange Ramps

Figure 34. FREEPLAN Maximum Service Volumes Screen
APPENDIX B:

LOSPLAN COMPONENT PROGRAM REVISION HISTORIES
ARTPLAN Revision History

Version 5.1.0 (official release, June 2003)

- Another revision to the sequence of inputs for the segment (auto) screen
  - Added median type input to segment screen
    - For files created with a previous version, the segment median type will be defaulted to that specified for the general facility median type

- Upper limit of % turns from exclusive lanes (PTXL) was changed from 45 to 65 for segment data input screen. Facility data input screen was left at 45%, but the status bar text now indicates that up to 65% can be entered in Segment screen.

- Added tool tip text to ‘Adjusted Sat Flow Rate’ input field, indicating the factors that influence this value.

- A new entry on the service volume tables form that indicates service volumes corresponding to an arterial with an unbalanced number of lanes between segments
  - This was also added to the formatted report (this required expanding printed report to 5 pages)
  - Added a label indicating the area type to the title bar of the service vols form
  - Some minor cosmetic enhancements were made to service vols form

- Additions/revisions to formatted report
  - Added: Program name, program version, segment median type
  - Re-ordered segment data fields to match with UI
  - Added segment number and ending cross street name for segment in segment input summary section
  - Revisions to formatted report for ‘no sidewalk’ selection -> ‘N/A’
  - Asterisk text from service volumes screen added to print preview/formatted report

- Linking to FDOT website from Help menu (LOS Handbook) and About ARTPLAN dialog box

- Minor revisions to On-line Help file

- Added logic to now determine whether user needs to be queried about saving data

- Added logic to file open/reading code such that a saved file with more than 9 segments will not bomb program—extra segment information just gets ignored.

- Added logic to check for over-capacity conditions for the full hour (1/PHF) on any segment and a corresponding warning message.
- Replaced custom XML reading routine with Microsoft’s XML reading utility (MSXML version 4)

- Added remote automation capability (i.e., program can be called remotely and manipulated from another application). This can be accomplished with a command line instruction and parameters. Documentation on this capability will be forthcoming.

- Added batch file processing capability (i.e., many data files can be automatically processed by HIGHPLAN, for LOS results)

**Version 5.0.4 (test release)**

- Re-ordered individual field restore defaults buttons to match re-ordering of segment input fields from previous version

- Minor revisions to On-line Help file

- Fix to calculations which resulted in program crash when all segment g/C values were set equal to 1.0

- The upper limit of peak hour volume was changed to 5000, regardless of total number of lanes. This will generally keep the AADT value from exceeding its upper limit of 100,000. (Is this the right version?)

  For example, \(5000/0.1 \text{ (K)} = 50,000 \rightarrow 50,000/0.5 \text{ (D)} = 100,000\)

**Version 5.0.3 (test release)**

- Rearranged input controls on segment data input page to correspond with sequence of roadway, traffic, and control variables shown on facility data input form

- Re-organized the formatted report so that the automobile inputs and LOS were grouped together, and likewise for multimodal

- The cross-street names were added to the printed report, in lieu of just a segment number

- The signals/mile input on the general facility data input screen and printed report now shows 2 decimal places
Bug Fixes

#1: Wrong error message appeared when a character was entered into the Local Adj. Factor box.

#2: Program allowed you to save a file with invalid data entered for hourly volume (segment data screen).

#3: Can input a value between 1 and 5 in the # of Dir. Lanes box without using arrow buttons, but using arrow buttons, can input a value between 1 and 4. Changed to allow a maximum of 4 directional lanes with arrow button.

#4: **NOTE: This bug caused the program to crash.** When trying to open a saved file with the Class Type as Signal, a fatal error message appeared.

#5: If Median Type was set to ‘Non-Restrictive’ or ‘None’ and then the results were calculated, upon returning to the General Facility Data page the Median Type was reset to Restrictive.

#6: **NOTE: This bug caused the program to crash.** An error message appeared when trying to open a saved file with either the ‘&’ or the ‘<’ and ‘>’ characters in any of the information boxes. These characters are generally invalid for XML purposes. If you really need to use these characters, use the following syntax, append ‘&’ with ‘&amp;’ and ‘<’ or ‘>’ with ‘&lt;’.

#7: Could type in any number or character into the Class box and perform a LOS analysis.

#8: **NOTE: This bug caused the program to crash** when the program was set with these parameters: Area Type as Transitioning/Urban, Median Type as Non-Restrictive, Class as III. Save the file, close, and then reopen it. An error message appeared and clicking OK shuts the program down.

#9: In Multimodal Segment Data, specifying Outside Lane Widths in segments 2 and 3 and then saving, it didn’t save the inputs and overrode with values of 8 in these segments.

#10: The Help file isn’t running from the pull-down menu. A shortcut on the desktop is created to get the Help file to work properly. This is a problem with the installation routine (fixed in the non NT-compatible version, not in the other version yet).

#11: Signal control type field did not link to appropriate Help file section.

#12: After clicking OK on the error message that appeared after inputting a K-factor out of range, the default value that was in the K-factor box reverted to an incorrect default value.

#13: Print Preview gave an error when a control input values contained the ‘&’ character.

#14: The Print Preview was not displaying the End Intersection value correctly.
#15: Some incorrect default values were displayed when the forms GenInput, SegInput, or MultiModal were displayed.

#16: When an alpha character was inputted into the ‘Outside Lane Width’ control and then the user tried to tab out, it gave the wrong error message.

#17: After performing an LOS with the Class box on Signal and the Area Type on Transitioning/Urban, an error message appeared when the user clicked back on the Edit Facility Data icon.

#18: When you saved a file with the Class control set to Signal, closed the file and then opened it, the Segment Button was enabled.

#19: When you increased the number of segments to the maximum and then clicked on the Restore Defaults Button, the Add Segments Button was disabled even though the number of segments is less than the maximum. The reverse situation was also true for the Remove Segments button.

#20: When you click on the LOS button, the Service Volumes Button gets enabled. When the Print Preview Form was invoked, the Service Volume Button was still enabled. This button should only be enabled when the user is viewing the LOS results.

#21: Fixed an error related to the sequence of file saving, closing, and then re-opening that resulted from a combination of rural area type and signal class inputs.

**Version 5.0.2 (test release)**

- Several user interface refinements, particularly with respect to data input validation
- Fixed a bus LOS calculation problem

**Version 5.0.1**

- Initial test release
HIGHPLAN Revision History

Version 1.1.0 (official release, June 2003)

- Level of Service results no longer appear upon start-up of the application, the LOS button must now be pressed to display results. This resolved an issue with the updating of the service volumes screen, in addition to a couple of other minor user interface issues.

- Added logic to now determine whether user needs to be queried about saving data

- Additions/revisions to formatted report
  - Added: Program name, program version, peak direction, study period, analysis type
  - Fixed problem with the displaying of number of lanes for service volumes
  - Fixed print preview problem for initial display of level of service MOE’s

- Moved ‘Analysis Type’ input from the ‘Roadway Variables’ section to the ‘Description’ section

- Changed the label ‘Adj. Capacity’ to just ‘Capacity’

- Added tool tip text to ‘Capacity’ input field, indicating the factors that influence this value.

- Incorrect tool tip text for ‘Base Capacity’. Text Removed.

- Changed ‘FFS’ field to user editable. Set the allowable range to 40 – 75 mph.

- Changed ‘Date’ field to user editable

- Re-ordered screen view and LOS toolbar buttons

- Minor revisions to status bar text descriptors

- Minor revisions to On-line Help file, including context specific topic indexing

- Changed the following XML file tag names (Note: Data sets created with previous versions of HIGHPLAN will not read with this version unless the following tag names are changed).
  - <Class_HCM> → <HighwayClass_HCM>
  - <PropPassingZone> → <NoPassZonePct>
  - <HVPcnt> → <HVPct>
  - <AverageTravelSpeed> → <AvgTravelSpeed>
Updates and Enhancements to the LOSPLAN User Interface and Computational Procedures

- Linking to FDOT website from Help menu (LOS Handbook) and About ARTPLAN dialog box
- Added remote automation capability (i.e., program can be called remotely and manipulated from another application). This can be accomplished with a command line instruction and parameters. Documentation on this capability will be forthcoming.
- Added batch file processing capability (i.e., many data files can be automatically processed by HIGHPLAN, for LOS results)
- Fixed bug that was defaulting passing lane spacing to 2 miles, even when no passing lanes were present
- Only two digits were being accommodated for % No Passing Zones, so an input value of '100' was being truncated to '10'. Thus, in version 1.0.4, the results were much more optimistic than they should have been for an input of 100% No Passing Zones.

Version 1.0.4 (test release)

- Minor revisions to On-line Help file
- Minor revisions to status bar text descriptors

Version 1.0.3 (test release)

Bug Fixes

#1: Could input any type of character in the % Heavy Vehicles box and % No Passing Zone box with no error message appearing.

#2: You were allowed to save a file with invalid characters in various input controls.

#3: Could get results after performing a LOS with an invalid character in the % Heavy Vehicles box.

#4: Could get different results after performing a LOS with invalid characters in more than one entry box (i.e. % No Passing and % Heavy Vehicles) than with an invalid entry in only one entry box (as above error).

#5: In certain situations, the program hung when changing some parameters after the program was idle for an extended amount of time.
Updates and Enhancements to the LOSPLAN User Interface and Computational Procedures

#6: The LOS and Service Volumes icons did not function with 4, 6, or 8 lanes selected, but did work with 2 lanes selected.

#7: If a parameter (such as Terrain) was changed, the Passing Lanes box stayed checked but the Spacing box turned gray. The Passing Lanes box had to be unchecked, then rechecked for the Spacing box to be activated.

#8: The User’s Guide under the Help menu did not execute. This is a problem with the installation routine (fixed in the non NT-compatible version, not in the other version yet).

#9: Clicking on the LOS icon immediately after entering a value not within range for any parameters still showed results at the bottom of the screen.

#10: The F LOS value was missing when you manipulated the parameters for multilane (only) facilities for failing conditions.

#11: When an invalid character was input into the % Heavy Vehicle field, the program input a value of zero in the Adj. Capacity field.

#12: A LOS evaluation could be performed with the % No Passing and % Heavy Vehicles boxes empty.

#13: **NOTE: This bug caused the program to crash.** Characters could be entered after numerical values in the AADT, Base Capacity, % Heavy Vehicles, and % No Passing Zone variable fields.

#14: For multilane, No-passing Zone is ‘N/A’. This caused non-numeric error checking problems.

#15: The Left Turn Lanes value (Yes or No) was not being read from a saved data file. The value always defaulted to unchecked (No).

#16: The Posted Speed box sometimes disappeared after opening a saved file.

#17: **NOTE: This bug caused the program to crash.** An error message appeared when trying to open a saved file with either the ‘&’ or the ‘<’ and ‘>’ characters in any of the information boxes. These characters are generally invalid for XML purposes. If you really need to use these characters, use the following syntax, append ‘&’ with ‘&amp;’ and ‘<’ or ‘>’ with ‘&gt;’.

#18: Any number up to 999 and any character could be typed in the Posted Speed box. A LOS inquiry could still be performed with the invalid number or character in the box.

#19: The Posted Speed values listing was reversed for the 2–lane and multilane conditions. Due to the 2-lane posted speed values being shown for the multilane situation, this caused the base saturation flow rate to be incorrect for certain speed selections.
#20: NOTE: This bug caused the program to crash when you opened a file after saving and closed the specific file (using File and Close). Upon opening the file, a fatal error message appeared.

#21: Upon closing a file that was opened from disk, the dialog box asking to save changes did not appear.

#22: The default passing lane spacing was changed from ‘0’ to ‘2’.

**Version 1.0.2 (test release)**

- Several user interface and calculation refinements

**Version 1.0.1 (test release)**

- Initial release
APPENDIX C:

BATCHPROCESSINGINSTRUCTIONS
The Batch Processing utility has been provided to allow users to process multiple ARTPLAN, HIGHPLAN, or FREEPLAN input files. The following sequence of events will be automatically performed on each file in a group of selected files: 1) the inputs from the file will be loaded into the corresponding LOSPLAN program; 2) the results will be calculated for those inputs; and 3) the results will be saved back into the original file.

The Batch Processing utility can be selected from the ‘File’ menu of any of the three LOSPLAN programs. Figure 35 below illustrates this for the ARTPLAN program.

![Figure 35. Batch Processing Utility selection from the File menu of ARTPLAN](image)

This action will then launch the Batch Processing utility, as shown in Figure 36 below. LOSPLAN files can be browsed for on connected drives and folders by using the drive and folder list boxes (left side of interface). Files will be displayed according to the program selected (middle of interface). For example, if the ARTPLAN button is selected, files in the selected drive/folder that begin with the ‘AP’ prefix will be displayed. Likewise, if the HIGHPLAN or FREEPLAN program is selected, files that begin with ‘HP’ or ‘FP’ will be displayed, respectively. Figure 37 shows several HIGHPLAN files being displayed. Double-clicking (the left mouse button) on a folder will automatically display files (according to the selected program). Alternatively, the ‘Display Files’ button can be pressed if a folder was only selected with a single click (the left mouse button).
The following steps describe how to specify the files to be processed:

1. Select the files of interest from the list displayed for the selected drive/folder (middle part of the interface).
a. Individual files can be selected by just clicking on them with the left mouse button, or the keyboard keys.
b. Multiple, non-contiguous, files can be selected by using the left mouse button while holding down the ‘control’ (or ‘ctrl’) key on the keyboard.
c. Multiple, contiguous, files can be selected by using the left mouse button while holding down the ‘shift’ key on the keyboard.

2. Transfer the selected file or files to the ‘Files to Run’ list box by pressing the arrow button that points to the right. Files can be removed from the ‘Files to Run’ box by selecting them (this must be done on an individual file basis) and pressing the arrow button that points to the left. Figure 38 shows the selection and transferring of the three listed ARTPLAN files.

![Batch Processing Utility](image)

**Figure 38. Selection and Transferring of Files to ‘Files to Run’ List Box.**

The last step required before the files can be processed is to save the file list. This is accomplished by pressing the ‘Save To File’ button. Pressing this button will bring up a file save dialog box as pictured in Figure 39.
Updates and Enhancements to the LOSPLAN User Interface and Computational Procedures

Figure 39. Save Files to Process Dialog Box

Choose the drive/folder location where you would like to save the file, type in any filename of your choice, and then press the ‘Save’ button. This will save a standard text file, as seen in Figure 40.

Figure 40. Saved Text File of Files to Process

Once the file list is saved, the ‘File List Run’ button becomes enabled, as shown in Figure 41. To start the automatic file processing, press this button.
Updates and Enhancements to the LOSPLAN User Interface and Computational Procedures

Figure 41. Interface with ‘File List Run’ Button Enabled after Saving File List

A previously saved file list can also be recalled by pressing the ‘Open File List’ button. This is illustrated in figures 8 and 9. Again, the ‘File List Run’ button will become enabled after loading a file list from a previously saved text file.

Figure 42. Open File List Dialog Box
When using this utility, a user will typically want to process multiple files. However, for the instance in which it is desired to process only a single file, the ‘Quick Run’ feature is also available. Although a single file can be specified for processing in the same manner as for multiple files (i.e., saving to a file list), the ‘Quick Run’ feature allows a single file to be processed directly, without saving to a file list.

The ‘Quick Run’ button will process the file that is currently selected in the file list box in the middle part of the interface. It does not reference any files listed in the ‘Files to Run’ box. For example, in Figure 44, pressing the ‘Quick Run’ button will process the ‘AP_test2.xml’ file.
Figure 44. Quick Run Example
APPENDIX D:

DATABASE INTERFACE EXAMPLE
Database Interfacing with ARTPLAN Example Tutorial

Open the ‘AP_DB example.mdb’ file, as seen in the Windows Explorer screen shot below.
This brings up the main database view. The ‘Tables’ view is shown in the figure below. This view shows a listing of all tables defined for the database. As a matter of notational convention, the tables are named with a prefixing ‘t’.
Double-clicking the name “tARTERIALINFO” shows the following table. Due to the width of the table, it is shown four separate screen shots.

<table>
<thead>
<tr>
<th>RID</th>
<th>ArterialName</th>
<th>FirstDirection</th>
<th>PeriodIC</th>
<th>SignalsPerMile</th>
<th>AreaType</th>
<th>ArterialClass</th>
<th>HCM</th>
<th>AADT</th>
<th>KFactor</th>
<th>DFactor</th>
<th>PLN</th>
<th>PHF</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Archer Blvd</td>
<td>Westbound</td>
<td>K100</td>
<td>5</td>
<td>Urbanized</td>
<td></td>
<td>4</td>
<td>90000</td>
<td>0.1</td>
<td>0.75</td>
<td>0.8</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CaseSatFlowPerLane</th>
<th>LocalAdjFactor</th>
<th>AdjSatFlowPerLane</th>
<th>FVPC</th>
<th>PctTurnXLane</th>
<th>NumberOfLanes</th>
<th>NumberOfLanesBothDir</th>
<th>PostedSpeed</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000</td>
<td>0.8</td>
<td>1800</td>
<td>3</td>
<td>12</td>
<td>6</td>
<td>8</td>
<td>45</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NumberOfIntersect</th>
<th>ArterialTypes</th>
<th>CycleLength</th>
<th>SGRatio</th>
<th>MedianType</th>
<th>PavementCondition</th>
<th>SidewalkSeparation</th>
<th>OutsideLnWidth</th>
<th>SidewalkBarrier</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>6</td>
<td>90</td>
<td>0</td>
<td>Restrictive</td>
<td>Typical</td>
<td>Typical</td>
<td>Typical</td>
<td>No</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SidewalkYN</th>
<th>SidewalkTelDueYN</th>
<th>BikeLrtYN</th>
<th>NumberOfBuses</th>
<th>SpanOfService</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>No</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>No</td>
<td>False</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Record</th>
<th>Datasheet View</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
</tbody>
</table>
Double-clicking the name “tGENERAL” shows the following table.

![Double-clicking the name “tGENERAL” shows the following table.](image1)

Double-clicking the name “tSEGMENT” shows the following table (in two screen shots).

![Double-clicking the name “tSEGMENT” shows the following table.](image2)

The display of the remaining tables is omitted here, but can be viewed in the same manner as the above tables.
To see how the records contained in the various tables are actually related to one another, select ‘Relationships…’ from the ‘Tools’ menu, as shown in the figure below.

This brings up the ‘Relationships’ window, as shown below.
Closing this window returns you back to the main database window. Now if we choose the ‘Queries’ view (left column) instead of ‘Tables’, a new listing appears, shown in the following figure. Queries provide a way to create new tables based upon a combination of fields established in the main tables.
For example, clicking on the “ALLINTERSECTION” query and choosing to see its design view, the window below will appear, which displays the fields (and corresponding tables) that comprise the query table of “ALLINTERSECTION”. Note that the definition of a query only needs to be done once, not every time one wants to export data to an XML file.
The following is the MS-SQL code which gets generated by Access.
SELECT tINTERSECTIONINFO.CrossStreetName,
tCONTROLLER.ControlMode,
tCONTROLLER.CycleLength,
tSEGMENT.SectionS,
tSEGMENT.GCRatio,
tSEGMENT.ArrivalType,
tSEGMENT.FreeFlowSpeed,
tSEGMENT.AADT,
tSEGMENT-DDHV,
tSEGMENT.PctTurnXLane,
tSEGMENT.NumberOfLanes,
tSEGMENT.MedianType,
tSEGMENT.BikeLN,YN,
tSEGMENT.OutsideLnWidth,
tSEGMENT.PavementCondition,
tSEGMENT.SidewalkYN,
tSEGMENT.SidewalkSeparation,
tSEGMENT.SidewalkBarrier,
tSEGMENT.SidewalkToBusYN,
tSEGMENT.NumberOfBuses,
tSEGMENT.SpanOfService
FROM (tINTERSECTIONINFO INNER JOIN tCONTROLLER ON tINTERSECTIONINFO.RID = tCONTROLLER.RID) INNER JOIN tSEGMENT ON tINTERSECTIONINFO.ID = tSEGMENT.ID;
Double-clicking the “ALLINTERSECTION” query will display the following table (two screen shots).

The above has been a basic overview of the database structure used in this example. Assuming one has already defined the structure (tables and queries) and populated the fields with data, the following discussion will describe the process for exporting these data to an ARTPLAN compatible input file.
From the ‘Queries’ window, select the ‘Agency’ query.

![Queries Window]

Then select ‘Export…’ from the ‘File’ menu. This can also be selected from a menu shown by clicking the right mouse button.

![Export Menu]
The following dialog box appears.

Choose the folder (from the ‘Save in:’ list box) where you would like to export the query. Type in a filename. In the ‘Save as type’ list box, choose ‘XML Documents (*.xml)’.
Enter a filename of choice. In this case, we have just left the default filename (same as the name of the query).

Click the ‘Export’ button. The following dialog box appears.

Uncheck “Schema of the data”.

Press the ‘OK’ button. The file is saved in the indicated folder, as shown below.
Repeat this process for all of the defined queries, shown in the query window. The final result is shown in the following Windows Explorer screen shot. Note that this process can be automated with an Access macro.
Next, run the ‘XMLdbMerge.exe’ utility (included on the enclosed CD). The main screen for this utility is shown in the following figure.

Locate the saved (exported) Access XML files using the drive and folder navigator controls on the left side of the screen. The files contained in the selected drive/folder will be displayed in the list box in the center of the screen (as shown above).

Select all the files, using a combination of the left mouse button and either the ‘control’ or ‘shift’ key.
Click on the ‘Open database XML files’ button. This will create the necessary references to these files. Next, click on the ‘Specify LOSPLAN XML file’ button. The following dialog box appears.

Choose the folder (from the ‘Save in:’ list box) where you would like to save the converted XML file. Type in a filename. In this example, we have chosen “APdbInput.xml” as the filename.

Press the ‘Save’ button. The main utility screen becomes active again.
Press the ‘Create LOSPLAN Input File’ button. This will launch the conversion routine. The ARTPLAN compatible input file will now be created, and is shown in the Windows Explorer screen shot (below). The conversion utility can be exited by clicking on the red ‘x’ in the upper right corner.
To view the contents of this file, simply double-click the file. It will automatically open in Internet Explorer. The screen shots below show the contents of this file (multiple screen shots due to the length of the file). This file can now be loaded into ARTPLAN by simply starting ARTPLAN, selecting ‘Open...’ from the ‘File’ menu, and then specifying this file for loading.
Updates and Enhancements to the LOSPLAN User Interface and Computational Procedures
APPENDIX E:

DLL DOCUMENTATION
Guidelines for adding the ARTPLAN calculations engine (APCalc.dll) to your Visual Basic project

1. Add a Reference to the ‘APCalc.dll’ to Your Visual Basic Project

1.1 Place ‘APCalc.dll’ file in project or ‘Windows\System’ directory
1.2 Go to the ‘Project’ menu item
1.3 Click on ‘References’
1.4 Then click on ‘Browse…’ to search for the APCalc.dll file
1.5 Then use the ‘Look in:’ Box to search for the APCalc.dll in your directory structure.
1.6 The ‘References’ dialog will now show APCalc.dll (as shown in the figure below)
1.7 Click ‘OK’. The DLL is now properly referenced to your VB project.

![References - ARTPLAN.vbp](image)

2. Declare DLL

Add the following statement to your VB project’s declarations section:
Public dll As APCalcs

3. Initialize DLL

Initialize the DLL in your project’s startup subroutine, with the following statement:
Set dll = New APCalcs
4. DLL Function Calls

Add the ‘DllCalc’ subroutine to your VB project (included below). This subroutine contains all the code and DLL function calls necessary to retrieve all auto and multimodal calculated performance measures and levels of service. The subroutine shown below makes use of the data structure in FDOT’s ARTPLAN. However, it is making explicit reference to each of the variable elements within the data structure so that you can easily substitute your own project’s variable names. Shown immediately below the subroutine listing is the specification for each of the variables used in the calculations DLL.

Public Sub DllCalc()

    Dim DllPkHrVolRet() As Single
    Dim DllBothDirVolRet() As Single
    Dim DllAADTfinal() As Single
    Dim DllAADTflag() As Boolean
    Dim DllServiceBike() As Single
    Dim DllServicePed() As Long
    Dim DllServiceBus() As Single
    Dim DllDailyServiceBus() As Single
    Dim i As Integer, ii As Integer, j As Integer

    '********************** Transfer input values to DLL **********************
    Call dll.InitialSysInfo(ArtInfo.NumSegments, SystemInfo.ArtClass, SystemInfo.AreaType, _
        SystemInfo.AADT, SystemInfo.Dfactor, SystemInfo.gCratio, SystemInfo.Kfactor, _
        SystemInfo.PHF, SystemInfo.PTXL, SystemInfo.BaseSatFlow, SystemInfo.FwdLanes, _
        SystemInfo.Cycle, SystemInfo.SigControl, SystemInfo.MedianType, _
        SystemInfo.PctHeavyVeh)

    For i = 1 To ArtInfo.NumSegments
        Call dll.InitialIntInfo(i, IntInfo(1, i).CrossName, IntInfo(1, i).Cycle, IntInfo(1, i).gCratio, _
            IntInfo(1, i).SegLength, IntInfo(1, i).SegAADT, IntInfo(1, i).PTXL, _
            IntInfo(1, i).NumLanes, IntInfo(1, i).ArvType, IntInfo(1, i).FFSpeed, _
            IntInfo(1, i).SegVol, IntInfo(1, i).MedianType)
    Next i
For i = 0 To ArtInfo.NumSegments - 1
    Call dll.InitialMMsegment(i, MMSegment(i).BikeLaneYN, MMSegment(i).OutLaneWid, _
        MMSegment(i).NumOutLaneWid, MMSegment(i).PavCond, MMSegment(i).SidewalkSep, _
        MMSegment(i).SidewalkYN, MMSegment(i).SidewalkBarr, MMSegment(i).SidewalkToBusYN, _
        MMSegment(i).BusesPerHour, MMSegment(i).SpanOfService)
    For ii = 0 To 2
        Call dll.PedSubSegInfo(i, ii, PedSubSeg(i).NumSubSeg, _
            PedSubSeg(i).PctOfSegment(ii), PedSubSeg(i).SidewalkYN(ii), _
            PedSubSeg(i).SidewalkSep(ii), PedSubSeg(i).SidewalkBarr(ii))
    Next ii
Next i

'******************** Get Adjusted Saturation Flow Value ******************
SystemInfo.AdjSatFlow = dll.AdjSatFlowRate(SystemInfo.PctHeavyVeh, SystemInfo.MedianType, _

'******************* Call the Calculations Routines *********************
Call dll.RunCalc

'******************** Get Auto Performance Measure Values and LOS ******************
For i = 1 To ArtInfo.NumSegments
    IntInfo(1, i).ThruVol = dll.ThruVolRet(i)
    IntInfo(1, i).vcRatio = dll.VcRatioRet(i)
    IntInfo(1, i).CtrlDelay = dll.CtrlDelayRet(i)
    IntInfo(1, i).IntLOS = dll.IntLosRet(i)
    SegInfo(1, i).AvgSpd = dll.SegAvgSpdRet(i)
    SegInfo(1, i).LOS = dll.SegLOSRet(i)
Next i

'************** Get Service Volume Table Values ******************
DllPkHrVolRet = dll.PkHrVolRet
DllBothDirVolRet = dll.BothDirVolRet
DllAADTfinal = dll.AADTfinalRet
DllAADTflag = dll.AADTflagRet
DllServicePed = dll.ServicePedRet
DllServiceBike = dll.ServiceBikeRet
DllServiceBus = dll.ServiceBusRet
DllDailyServiceBus = dll.DailyServiceBusRet

For j = 1 To 4 'lanes 2,4,6,8
    For i = 1 To 5 'LOS A - E
        PkHrVol(j, i) = DllPkHrVolRet(j, i)
        BothDirVol(j, i) = DllBothDirVolRet(j, i)
        AADTfinal(j, i) = DllAADTfinalRet(j, i)
        AADTflag(j, i) = DllAADTflagRet(j, i)
        ServiceBike(j, i) = DllServiceBike(j, i)
        ServicePed(j, i) = DllServicePed(j, i)
    Next i
Next j
For i = 1 To 6
    ServiceBus(i) = DllServiceBus(i)
    DailyServiceBus(i) = DllDailyServiceBus(i)
Next i

' check for oversaturation for entire hour of analysis (i.e., 1/PHF)
For i = 1 To ArtInfo.NumSegments
    OverVC(i) = dll.OverVCRet(i)
Next i

*************** Get Multimodal Performance Measure Values ***************

For i = 1 To ArtInfo.NumSegments
    BkLosVal(i) = dll.BikeLosValRet(i)
    PedLosVal(i) = dll.PedLosValRet(i)
    TransitLosVal(i) = dll.TransitLosValRet(i)
Next i

For i = 1 To ArtInfo.NumSegments
    Arterial.segresult(i).BikeLOS = dll.segBikeLosRet(i)
    Arterial.segresult(i).PedLOS = dll.SegPedLosRet(i)
    Arterial.segresult(i).TransitLOS = dll.SegTransitLosRet(i)
Next i

For i = 1 To 8
    For j = 1 To 3 '# of ped subsegments
        Arterial.segresult(i).SubSegPedLOS(j) = dll.PedSubSegLosRet(i, j)
    Next j
Next i

*************** Get Overall Arterial LOS Results ***************

ArtInfo.AvgSpd = dll.ArtInfoAvgSpdRet
ArtInfo.LOS = dll.ArtInfoLOSRet
ArtInfo.SumLength = dll.ArtSumLengthRet
Arterial.TotPedLOS = dll.TotPedLosRet
Arterial.TotPedPts = dll.TotPedPtsRet
Arterial.TotBikeLOS = dll.TotBikeLosRet
Arterial.TotBikePts = dll.TotBikePtsRet
Arterial.TotBusLOS = dll.TotBusLosRet
Arterial.TotBusPts = dll.TotBusPtsRet

End Sub

5. Calculations Subroutine Call

Insert the following statement in your VB project code at the point where you want to retrieve calculations results:

    Call DllCalc
Variable Descriptions

Facility (SystemInfo. & ArtInfo.) Variables

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Data Type</th>
<th>Allowable Values</th>
<th>Units / Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>NumSegments</td>
<td>Integer</td>
<td>0, 1, … , 9</td>
<td></td>
</tr>
<tr>
<td>ArtClass</td>
<td>Integer</td>
<td>1, 2, 3, 4, 5</td>
<td>5 = Signal</td>
</tr>
<tr>
<td>AreaType</td>
<td>String</td>
<td>“Urbanized”, “Transitioning/Urban”,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>“Rural”</td>
<td></td>
</tr>
<tr>
<td>AADT</td>
<td>Long</td>
<td>0 – 100,000</td>
<td>vehicles</td>
</tr>
<tr>
<td>Dfactor</td>
<td>Single</td>
<td>0.5 – 1</td>
<td></td>
</tr>
<tr>
<td>Kfactor</td>
<td>Single</td>
<td>0.01 - 0.15</td>
<td></td>
</tr>
<tr>
<td>PHF</td>
<td>Single</td>
<td>0.75 – 1.0</td>
<td></td>
</tr>
<tr>
<td>PTXL</td>
<td>Single</td>
<td>0 – 45</td>
<td>% Turns from Exclusive Lanes</td>
</tr>
<tr>
<td>BaseSatFlow</td>
<td>Long</td>
<td>100 to 2400</td>
<td>FDOT default = 1850 pc/hr/ln</td>
</tr>
<tr>
<td>gCratio</td>
<td>Single</td>
<td>0.1 – 1</td>
<td></td>
</tr>
<tr>
<td>FwdLanes</td>
<td>Integer</td>
<td>1 – 4</td>
<td></td>
</tr>
<tr>
<td>Cycle</td>
<td>Integer</td>
<td>40 – 240</td>
<td>seconds</td>
</tr>
<tr>
<td>SigControl</td>
<td>String</td>
<td>“Pretimed”, “Semiactuated”, “Actuated”</td>
<td></td>
</tr>
<tr>
<td>MedianType</td>
<td>String</td>
<td>“None”, “Non-Restrictive”, “Restrictive”</td>
<td></td>
</tr>
<tr>
<td>PctHeavyVeh</td>
<td>Single</td>
<td>0 – 100</td>
<td>%</td>
</tr>
<tr>
<td>OverVC</td>
<td>Boolean</td>
<td>True, False</td>
<td>v/c &gt; 1/PHF indicator</td>
</tr>
</tbody>
</table>

Segment (IntInfo.) Variables

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Data Type</th>
<th>Allowable Values</th>
<th>Units / Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CrossName</td>
<td>String</td>
<td>Any String Value</td>
<td></td>
</tr>
<tr>
<td>Cycle</td>
<td>Integer</td>
<td>40 – 240</td>
<td>seconds</td>
</tr>
<tr>
<td>gCratio</td>
<td>Single</td>
<td>0.1 – 1</td>
<td></td>
</tr>
<tr>
<td>SegLength</td>
<td>Integer</td>
<td>100 – 15840</td>
<td>feet</td>
</tr>
<tr>
<td>SegAADT</td>
<td>Long</td>
<td>1000 – 100000</td>
<td>Vehicles (optional, see below)</td>
</tr>
<tr>
<td>SegVol</td>
<td>Integer</td>
<td>0 – 5000</td>
<td>vehicles (analysis direction), if equal to zero, SegVol = SegAADT * Kfactor * Dfactor</td>
</tr>
<tr>
<td>PTXL</td>
<td>Single</td>
<td>0 – 65</td>
<td>%</td>
</tr>
<tr>
<td>NumLanes</td>
<td>Single</td>
<td>1 – 4</td>
<td>analysis direction</td>
</tr>
<tr>
<td>ArvType</td>
<td>Integer</td>
<td>1 – 6</td>
<td></td>
</tr>
<tr>
<td>FFSpeed</td>
<td>Integer</td>
<td>25 – 60</td>
<td>mi/hr</td>
</tr>
</tbody>
</table>
### MultiModal (MMSegment.) Variables

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Data Type</th>
<th>Allowable Values</th>
<th>Units / Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>BikeLaneYN</td>
<td>Integer</td>
<td>0, 1</td>
<td>no, yes</td>
</tr>
<tr>
<td>OutLaneWid</td>
<td>Integer</td>
<td>0, 1, 2, 3</td>
<td>Narrow, Typical, Wide, Specify Width</td>
</tr>
<tr>
<td>NumOutLaneWid</td>
<td>Integer</td>
<td>8 – 16</td>
<td>Feet (applies to selection of 3 for above)</td>
</tr>
<tr>
<td>PavCond</td>
<td>Integer</td>
<td>0, 1, 2</td>
<td>Undesirable, Typical, Desirable</td>
</tr>
<tr>
<td>SidewalkSep</td>
<td>Integer</td>
<td>0, 1, 2</td>
<td>Adjacent, Typical, Wide</td>
</tr>
<tr>
<td>SidewalkYN</td>
<td>Integer</td>
<td>0, 1</td>
<td>no, yes</td>
</tr>
<tr>
<td>SidewalkBarr</td>
<td>Integer</td>
<td>0, 1</td>
<td>no, yes</td>
</tr>
<tr>
<td>SidewalkToBusYN</td>
<td>Integer</td>
<td>0, 1</td>
<td>no, yes</td>
</tr>
<tr>
<td>BusesPerHour</td>
<td>Integer</td>
<td>0 – 60</td>
<td>buses/hr</td>
</tr>
<tr>
<td>SpanOfService</td>
<td>Integer</td>
<td>0 – 24</td>
<td>hours</td>
</tr>
</tbody>
</table>

### PedSubsegment (PedSubSeg.) Variables

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Data Type</th>
<th>Allowable Values</th>
<th>Units / Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>NumSubSeg</td>
<td>Integer</td>
<td>1, 2, 3</td>
<td></td>
</tr>
<tr>
<td>PctOfSegment</td>
<td>Integer</td>
<td>0 – 100</td>
<td>%</td>
</tr>
<tr>
<td>SidewalkYN</td>
<td>Integer</td>
<td>0, 1</td>
<td>no, yes</td>
</tr>
<tr>
<td>SidewalkSep</td>
<td>Integer</td>
<td>0, 1, 2</td>
<td>Adjacent, Typical, Wide</td>
</tr>
<tr>
<td>SidewalkBarr</td>
<td>Integer</td>
<td>0, 1</td>
<td>no, yes</td>
</tr>
</tbody>
</table>

### Adjusted Saturation Flow Variables

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Data Type</th>
<th>Allowable Values</th>
<th>Units / Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PctHeavyVeh</td>
<td>Single</td>
<td>0 – 100</td>
<td>%</td>
</tr>
<tr>
<td>MedianType</td>
<td>String</td>
<td>“None”, “Non-Restrictive”, “Restrictive”</td>
<td></td>
</tr>
<tr>
<td>BaseSatFlow</td>
<td>Long</td>
<td>100 to 2400</td>
<td>FDOT default = 1850 pc/hr/ln</td>
</tr>
<tr>
<td>LTBayYN</td>
<td>Integer</td>
<td>0, 1</td>
<td>no, yes</td>
</tr>
<tr>
<td>LocAdjFactor</td>
<td>Single</td>
<td>.75 – 1.0</td>
<td></td>
</tr>
</tbody>
</table>
Guidelines for adding the HIGHPLAN calculations engine (HPCalc.dll) to your Visual Basic project

1. Add a Reference to the ‘HPCalc.dll’ to Your Visual Basic Project

1.1 Place ‘HPCalc.dll’ file in project or ‘Windows\System32’ directory
1.2 Go to the ‘Project’ menu item
1.3 Click on ‘References’
1.4 Then click on ‘Browse…’ to search for the HPCalc.dll file
1.5 Then use the ‘Look in:’ Box to search for the HPCalc.dll in your directory structure.
1.6 The ‘References’ dialog will now show HPCalc.dll (as shown in the figure below)
1.7 Click ‘OK’. The DLL is now properly referenced to your VB project.

2. Declare DLL

Add the following statement to your VB project’s declarations section:

Public dll As TwoLaneCalc
Public Mdll As MultiLaneCalc

3. Initialize DLL

Initialize the DLL in your project’s startup subroutine, with the following statements:

Set dll = New TwoLaneCalc
Set Mdl = New MultiLaneCalc

4. DLL Function Calls

Add the ‘TwoLaneDLLCall’ and ‘MultiLaneDLLCall’ subroutines to your VB project (included below). These subroutines contain all the code and DLL function calls necessary to retrieve all calculated performance measures and levels of service for either two-lane or multilane highways. The subroutines shown below make use of the data structure in FDOT’s HIGHPLAN program. However, it is making explicit reference to each of the variable elements within the data structure so that you can easily substitute your own project’s variable names. Shown immediately below the subroutine listings is the specification for each of the variables used in the calculations DLLs.

Two-Lane Highways

Public Sub TwoLaneDLLCall()

Dim i As Integer
Dim DDHV As Single
Dim DIILOSTabRet() As TabStuff

'******************** Transfer input values to DLL ********************

Call dll.InitialHighInfo(HighwayInfo.AreaType, HighwayInfo.NumberOfLns, _
HighwayInfo.MedianYN, HighwayInfo.LTBaysYN, _
HighwayInfo.PassLnYN, HighwayInfo.PassingLnSpacing, _
HighwayInfo.PctNoPassingZone, _
HighwayInfo.AADT, HighwayInfo.KFactor, HighwayInfo.Dfactor, _
HighwayInfo.PHF, HighwayInfo.HVPct, HighwayInfo.BaseCapPerLn, _
HighwayInfo.LocalAdj, _
HighwayInfo.AnalysisType, HighwayInfo.Class)

Call dll.Setup2Lane (HP2LaneParPath)

DDHV = dll.RetDDHV
Call dll.TwolaneMOEs(DDHV, 0)

'********************** Get LOS Results **********************

HighwayInfo.VCRatio = dll.RetVCRatio
HighwayInfo.PTSF = dll.RetPTSF
HighwayInfo.ATS = dll.RetATS
HighwayInfo.PctFFS = dll.RetPctFFS
HighwayInfo.LOSMOE = dll.RetLOSMOE
HighwayInfo.LOS = dll.RetLOS

For i = 0 To 4
    HighwayInfo.MOE(i) = dll.RetMOE(i)
Next i
HighwayInfo.MOE(1) = HighwayInfo.VCRatio

Call dll.TwoLaneServiceVols
DllLOSTabRet = dll.LOSTabRet

For i = 1 To 5 'LOS A - E
    LOSTable(1).PkServiceVol(i) = DllLOSTabRet(1).PkServiceVol(i)
    LOSTable(1).BothServiceVol(i) = DllLOSTabRet(1).BothServiceVol(i)
    LOSTable(1).MaxVCRatio(i) = DllLOSTabRet(1).MaxVCRatio(i)
    LOSTable(1).MaxAADT(i) = DllLOSTabRet(1).MaxAADT(i)
Next i

End Sub

**MultiLane Highways**

Public Sub MultiLaneDLLCall()

Dim i As Integer, j As Integer
Dim DllLOSTabMulRet() As TabStuff

********** Transfer input values to DLL **********

Call Mdll.InitialMulLaneHighInfo(HighwayInfo.AreaType, HighwayInfo.Terrain, _
    HighwayInfo.MedianYN, HighwayInfo.LTBaysYN, _
    HighwayInfo.AADT, HighwayInfo.KFactor, HighwayInfo.Dfactor, _
    HighwayInfo.PHF, HighwayInfo.HVPct, HighwayInfo.BaseCapPerLn, _
    HighwayInfo.LocalAdj, HighwayInfo.AnalysisType)

Call Mdll.MultiLaneMOEs

********** Get Intermediate Calculation Values **********

FacAdjFactor = dll.retFacAdjFact
Adj_Med_LTB = dll.retAdjMedLT
    HighwayInfo.AdjCapPerLn = Mdll.AdjCapPerLnMulRet

'*************** Get LOS Results ***************

    HighwayInfo.VCRatio = Mdll.RetVCRatioML
    HighwayInfo.ATS = Mdll.RetATSML
    HighwayInfo.Density = Mdll.RetDensityML
    HighwayInfo.LOSMOE = dll.RetLOSMOE
    HighwayInfo.LOS = Mdll.RetLOSML

For i = 0 To 4
    HighwayInfo.MOE(i) = dll.RetMOE(i)
Next i
    HighwayInfo.MOE(1) = HighwayInfo.VCRatio

DllLOSTabMulRet = Mdll.LOSTabRet

For i = 1 To 3  'for 4, 6, and 8 lanes
    For j = 1 To 5  'LOS A - E
        LOSTable(i).PkServiceVol(j) = DllLOSTabMulRet(i).PkServiceVol(j)
        LOSTable(i).BothServiceVol(j) = DllLOSTabMulRet(i).BothServiceVol(j)
        LOSTable(i).MaxVCRatio(j) = DllLOSTabMulRet(i).MaxVCRatio(j)
        LOSTable(i).MaxAADT(j) = DllLOSTabMulRet(i).MaxAADT(j)
    Next j
Next i

End Sub

5. Calculations Subroutine Call

Insert the following statement in your VB project code at the point where you want to retrieve calculations results:

    Call TwoLaneDLLCall (for two-lane calculations)
    Call MultiLaneDLLCall (for multilane calculations)
### Variable Specifications

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Data Type</th>
<th>Allowable Values</th>
<th>Units / Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>AnalysisType</td>
<td>Integer</td>
<td>0, 1</td>
<td>“Facility”, “Segment”</td>
</tr>
<tr>
<td>AreaType</td>
<td>String</td>
<td>“Urbanized”, “Transitioning /Urban”, “Rural developed”, “Rural undeveloped”</td>
<td></td>
</tr>
<tr>
<td>NumberOfLns</td>
<td>Integer</td>
<td>2 (2 lane) 4 – 8 (multilane)</td>
<td></td>
</tr>
<tr>
<td>Terrain</td>
<td>Integer</td>
<td>0, 1</td>
<td>“Level”, “Rolling”</td>
</tr>
<tr>
<td>FreeFlowSpeed</td>
<td>Integer</td>
<td>40 – 70 (2 lane) 45 – 70 (multilane)</td>
<td>FDOT default = posted speed + 5 mi/h</td>
</tr>
<tr>
<td>MedianYN</td>
<td>Boolean</td>
<td>True / False</td>
<td></td>
</tr>
<tr>
<td>LTBaysYN</td>
<td>Boolean</td>
<td>True / False</td>
<td></td>
</tr>
<tr>
<td>AADT</td>
<td>Long</td>
<td>1000 – 100000 vehicles</td>
<td></td>
</tr>
<tr>
<td>Kfactor</td>
<td>Single</td>
<td>0.01 – 0.2</td>
<td></td>
</tr>
<tr>
<td>Dfactor</td>
<td>Single</td>
<td>0.5 – 1</td>
<td></td>
</tr>
<tr>
<td>PHF</td>
<td>Single</td>
<td>0.75 – 0.98</td>
<td></td>
</tr>
<tr>
<td>HVPct</td>
<td>Integer</td>
<td>0 – 100</td>
<td></td>
</tr>
<tr>
<td>BaseCapPerLn</td>
<td>Integer</td>
<td>1400 – 2400</td>
<td>FDOT default = 1850 pc/h/ln</td>
</tr>
<tr>
<td>LocalAdj</td>
<td>Single</td>
<td>0.8 – 1.0</td>
<td></td>
</tr>
</tbody>
</table>

**Two-Lane Highways Only**

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Data Type</th>
<th>Allowable Values</th>
<th>Units / Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>String</td>
<td>“I”, “II”, “III”, “IV”</td>
<td></td>
</tr>
<tr>
<td>PassLnYN</td>
<td>Boolean</td>
<td>True / False</td>
<td></td>
</tr>
<tr>
<td>PassingLnSpacing</td>
<td>String</td>
<td>0 (if PassLnYN = False) 2 – 30 (if PassLnYN = True)</td>
<td>mi</td>
</tr>
<tr>
<td>PctNoPassingZone</td>
<td>String</td>
<td>0 – 100</td>
<td>%</td>
</tr>
<tr>
<td>HP2LaneParPath</td>
<td>String</td>
<td>Path of ‘HP2Lane.par’ file</td>
<td></td>
</tr>
</tbody>
</table>
Guidelines for adding the FREEPLAN calculations engine (FPCalc.dll) to your Visual Basic project

1. Add a Reference to the ‘FPCalc.dll’ to Your Visual Basic Project

   1.1 Place ‘FPCalc.dll’ file in project or ‘Windows\System32’ directory
   1.2 Go to the ‘Project’ menu item
   1.3 Click on ‘References’
   1.4 Then click on ‘Browse…’ to search for the FPCalc.dll file
   1.5 Then use the ‘Look in:’ Box to search for the FPCalc.dll in your directory structure.
   1.6 The ‘References’ dialog will now show FPCalc.dll (as shown in the figure below)
   1.7 Click ‘OK’. The DLL is now properly referenced to your VB project.

![References - Project1.vbp](image)

2. Declare DLL

   Add the following statement to your VB project’s declarations section:
   ```vbscript
   Public dll As FPCalcs
   ```

3. Initialize DLL

   Initialize the DLL in your project’s startup subroutine, with the following statement:
   ```vbscript
   Set dll = New FPCalcs
   ```
4. DLL Function Calls

Add the 'CalcsDLL' subroutine to your VB project (included below). This subroutine contains all the code and DLL function calls necessary to retrieve all facility and segment calculated performance measures and levels of service. The subroutine shown below makes use of the data structure in FDOT’s FREEPLAN. However, it is making explicit reference to each of the variable elements within the data structure so that you can easily substitute your own project’s variable names. Shown immediately below the subroutine listing is the specification for each of the variables used in the calculations DLL.

Public Sub DllCalc() 'FPCalc DLL
Dim i As Integer, j As Integer, k As Integer

' ********** Initialize the Facility Variables **********
Call dll.InitialFacility(facility.AreaType, facility.FreewayClass, facility.numseg, facility.AADT, _
    facility.KFactor, facility.DFactor, facility.PeakhourFactor, facility.LocalAdjFactor, _
    facility.timePeriod, facility.direction, facility.peak, _
    facility.speedLimit, facility.default.Lanes, _
    facility.default.offrampDecelLength, facility.default.onRampAccelLength, _
    facility.default.PercentTrucks, facility.default.percenttrucksonoff, _
    facility.default.rampFFS, facility.default.percentruplantvolume, _
    facility.HCManalysis)

' ********** Initialize the Segment Variables **********
For i = 0 To facility.numseg – 1 'Segment
    For j = 0 To 2 '* see note at bottom
        Call dll.InitialSegment(i, j, facility.segarray(i).Changelnt, _
            facility.segarray(i).offRampPercentTrucks(j), _
            facility.segarray(i).onRampPercentTrucks(j), _
            facility.segarray(i).onRampVPH(j), facility.segarray(i).offRampVPH(j), _
            facility.segarray(i).onramplanes(j), facility.segarray(i).offramplanes(j), _
            facility.segarray(i).Length, _
            facility.segarray(i).InbetweenLength, _
            facility.segarray(i).AuxLaneBetweenInterchanges, _
            facility.segarray(i).auxlane, facility.segarray(i).Lanes, _
            facility.segarray(i).Terrain, facility.segarray(i).ffs, _
            facility.segarray(i).Type, _
            facility.segarray(i).Distance(j), facility.segarray(i).typenum)
    Next j
Next i

* This index is for accommodating the full cloverleaf interchange. The first on (loop)- and off (directional)-ramps use index 0 and the second on-(directional) and off-(loop) ramps use index 1. Three distances are also specified for full-cloverleaf: 1) first off-ramp gore to first on-ramp gore; 2) first on-ramp gore to second off-ramp gore; and 3) second off-ramp gore to second on-ramp gore. Thus, indexes 0,1, and 2 would be used, respectively. For all other interchange types, the zero index should be used to specify on-/off-ramp values and gore-to-gore distances. It is necessary to enter a segment length for all basic segment entries (i.e., indexes 0,1,2)
' *********** Call the Calculation Module ***********

dll.DoCalcs

' *********** Return Variables for the Result Screen ***********

For k = 0 To facility.numseg - 1
    facility.segresult(k).los = dll.segresultlos(k)
    facility.segresult(k).speed = dll.segresultspeed(k)
    facility.segresult(k).density = dll.segresultdensity(k)
    facility.segresult(k).capacity = dll.segresultcapacity(k)
    Involume(k) = dll.Volume(k)
    facility.segworst(k).ramp = dll.segworstramp(k)
    facility.segworst(k).los = dll.segworstlos(k)
    facility.segworst(k).density = dll.segworstdensity(k)
    facility.segworst(k).speed = dll.segworstspeed(k)
    facility.segworst(k).vcratio = dll.segworstvcratio(k)
Next k

' *********** Overall Values on the Result Screen ***********

    facility.overallDensity = dll.overallDensity
    facility.overallLOS = dll.overallLOS
    facility.overallSpeed = dll.overallSpeed

End Sub

5. Calculations Subroutine Call

   Insert the following statement in your VB project code at the point where you want to retrieve calculations results:

   Call DllCalc
### Variable Specifications

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Data Type</th>
<th>Allowable Values</th>
<th>Units / Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>numseg</td>
<td>String</td>
<td>1 – 20</td>
<td></td>
</tr>
<tr>
<td>AADT</td>
<td>Long</td>
<td>5,000 – 300,000 vehicles</td>
<td></td>
</tr>
<tr>
<td>KFactor</td>
<td>Single</td>
<td>0.01 – 0.40</td>
<td></td>
</tr>
<tr>
<td>DFactor</td>
<td>Single</td>
<td>0.4 – 1.0</td>
<td></td>
</tr>
<tr>
<td>PHF</td>
<td>Single</td>
<td>0.5 – 1.0</td>
<td></td>
</tr>
<tr>
<td>LocalAdjFactor</td>
<td>Single</td>
<td>0.75 – 1.0</td>
<td></td>
</tr>
<tr>
<td>timePeriod</td>
<td>String</td>
<td>K30, K100, K5-6pm, Kp/d, Kother</td>
<td></td>
</tr>
<tr>
<td>direction</td>
<td>String</td>
<td>Eastbound, Westbound, Northbound, Southbound</td>
<td></td>
</tr>
<tr>
<td>peak</td>
<td>String</td>
<td>Peak Direction, Off-Peak Direction</td>
<td></td>
</tr>
<tr>
<td>AreaType</td>
<td>String</td>
<td>Urbanized, Transitioning/Urban, Rural</td>
<td></td>
</tr>
<tr>
<td>FreewayClass</td>
<td>String</td>
<td>1 – 4</td>
<td></td>
</tr>
<tr>
<td>speedLimit</td>
<td>Integer</td>
<td>50 – 70</td>
<td>mi/h</td>
</tr>
<tr>
<td>defaultLanes</td>
<td>Integer</td>
<td>4 – 12</td>
<td>lanes both direction</td>
</tr>
<tr>
<td>offrampDecelLength</td>
<td>Integer</td>
<td>Default value – 500</td>
<td></td>
</tr>
<tr>
<td>onRampAccelLength</td>
<td>Integer</td>
<td>Default value – 1200</td>
<td></td>
</tr>
<tr>
<td>PercentTrucks</td>
<td>Integer</td>
<td>Default value – 6</td>
<td>Entering first segment</td>
</tr>
<tr>
<td>percenttrucksonoff</td>
<td>Integer</td>
<td>Default value – 6</td>
<td></td>
</tr>
<tr>
<td>rampFFS</td>
<td>Integer</td>
<td>Default value – 40</td>
<td></td>
</tr>
<tr>
<td>percentrampvolume</td>
<td>Integer</td>
<td>Default value – 10</td>
<td></td>
</tr>
<tr>
<td>HCManalysis</td>
<td>Boolean</td>
<td>True / False</td>
<td></td>
</tr>
</tbody>
</table>

### Segment Variables

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Data Type</th>
<th>Allowable Values</th>
<th>Units / Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ChangeInts</td>
<td>Boolean</td>
<td>True, False</td>
<td></td>
</tr>
<tr>
<td>offRampPercentTrucks</td>
<td>Single</td>
<td>0 – 100</td>
<td>%</td>
</tr>
<tr>
<td>onRampPercentTrucks</td>
<td>Single</td>
<td>0 – 100</td>
<td>%</td>
</tr>
<tr>
<td>onRampVPH</td>
<td>Integer</td>
<td>0 – 2200</td>
<td>veh/hr/ln</td>
</tr>
<tr>
<td>offRampVPH</td>
<td>Integer</td>
<td>0 – 2200</td>
<td>veh/hr/ln</td>
</tr>
<tr>
<td>onramplanes</td>
<td>Integer</td>
<td>1 – 2</td>
<td></td>
</tr>
<tr>
<td>offramplanes</td>
<td>Integer</td>
<td>1 – 2</td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td>Integer</td>
<td>&gt; 200, if back-to-back interchanges 0, otherwise</td>
<td>ft</td>
</tr>
<tr>
<td>InbetweenLength</td>
<td>Integer</td>
<td>2000 – 7200 default = 3000</td>
<td>ft, dist between back-to-back interchanges</td>
</tr>
<tr>
<td>AuxLaneBetweenInterchanges</td>
<td>Boolean</td>
<td>True, False</td>
<td></td>
</tr>
<tr>
<td>auxlance</td>
<td>Integer</td>
<td>2000 – 7200</td>
<td>ft, distance of aux lane</td>
</tr>
<tr>
<td>Lanes</td>
<td>Integer</td>
<td>2 – 6</td>
<td></td>
</tr>
<tr>
<td>Terrain</td>
<td>String</td>
<td>L, R, M</td>
<td>level, rolling, mountainous</td>
</tr>
<tr>
<td>---------</td>
<td>--------</td>
<td>---------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>ffs</td>
<td>Integer</td>
<td>55 – 75</td>
<td>mi/h</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
<td>Basic Segment, Interchange, Diamond, Partial Cloverleaf, Full Cloverleaf, On Ramp, Off Ramp, Toll Plaza</td>
<td></td>
</tr>
<tr>
<td>Distance</td>
<td>Single</td>
<td>ft, ramp gore-to-gore distance</td>
<td></td>
</tr>
<tr>
<td>typenum</td>
<td>Integer</td>
<td>Basic Segment = 0, Interchange = 1, Diamond = 2, Partial Cloverleaf = 5, Full Cloverleaf = 6, On Ramp = 7, Off Ramp = 8, Toll Plaza = 11</td>
<td></td>
</tr>
</tbody>
</table>